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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operate and
get a better understanding of the technical data of the signal modules, power supply
modules and interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The 10 I/Os Family PLCs are Open Type Controllers. It is required that you install the 10
I/0s PLC in a housing, cabinet, or electric control room. Entry to the housing, cabinet,



or electric control room should be limited to authorized personnel. Failure to follow
these installation requirements could result in severe personal injury and/or property
damage. Always follow these requirements when 10 1/Os family PLCs.

In case of installation or maintenance of the 10 I/Os please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.
Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'’équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille 10 1/Os sont des contrdleurs de type ouvert. Il est
nécessaire d'installer I'automate 10 I/Os dans un boitier, une armoire ou une salle de
contrdle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille 10 1/Os.

En cas d'installation ou de maintenance du 10 I/Os, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmospheére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.



Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN
DESSIGNED TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL
SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third-party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS'’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.



Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification - External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification - Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions because of improper operation of
the system and/or failure to dispose of components safely and correctly.



Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’'S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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1. 10 I/0s Digital Module: General Features

COMPACT PLC 10 I/0Os DIGITAL MODULE CPU
ARDUINO NANO

Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection
Input rated voltage 24 vde
Rated Power 30W
| Max. 1,5A
Size 100x45x115
Clock Speed 16 MHz
32KB of which 2KB are used by
Flash Memory bootloader
SRAM 2 KB
EEPROM 1KB
Communications USB - RS485 - ETH MAX487CSA - W5500
. . Onl_y meant for uploading or Cannot be working in a
USB Consideration! debugglr;gs,er}?;eil:v:{)smcigggected as final application
TOTAL Input points 10
TOTAL Output points 10
3.3t0 24 Vdc
Freq: 10 Hz

Input Impedance: 27K
Separated PCB ground
Rated Voltage: 10 Vac
Digital Input 10bit ) .

3.3 - 24 Vdc 220 Vac (3 —48 Vdc) Antipolarity + Overcurrent

Input Impedance: 54K (220 Ac)
220 VAc (3 - 48 Vdc) Rated Voltage: 220 Vac

I min: 2 to 12 mA
Opto-isolation
Rated Voltage: 24 Vdc

24 Vdc (23,2 Vdc)
Digital Isol 40 | max: 300 mA
igital Isolated Output Optro-isolation .
(5 - 24Vdc) Rated Voltage: 24Vdc i 22l L
Expandability USB - RS485 - ETH
Reference IS. 013001000100

NOTE: You can choose whether to use a digital input or a digital output from the internal

jumper configuration. You cannot use an input and an output at the same time with the same
nomenclature (e.g. 10.9 & Q0.9).

The maximum number of I/Os that can be used at the same time is 10. In section 7 of this
manual you can see how to individually configure each of them from the jumpers in the
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equipment hardware and configure the combination of inputs and outings that best suit your

needs.

2. Technical Specifications

2.1

General Specifications:

Power supply
voltage

DC power supply

12 to 24Vdc _—=

Operating
voltage range

DC power supply

11.4t025.4Vdc ===

Power

consumption DC power supply 30 VAC max.
External Power supply voltage | 24vdc ===
power supply
Power supply output 300 mA

capacity

Insulation resistance

20MQ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 2849 max.

2.2

Performance Specification:

Board

ARDUINO NANO EVERY BOARD WITH HEADERS

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega4809

Flash Memory

48KB of which 2kB are used by bootloader

11
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Program capacity (SRAM) 6KB
EEPROM 156B
Clock Speed 16 MHz
2.3  Symbology

Table that includes all the symbology that is used in the serigraph of the PLC 10 I/Os Digital
Module CPU Aduino Nano:

Svmbol Standard No./ Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : : .
] Graphical symbols 5031 / Direct Inohcates that_ the equipment |§
E EE =Em suitable for direct current only;
for use on Current . : ;
; to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols , suitable for alternating current
N for use on 5032 C/:Alternatmg only; to identify relevant
: urrent :
equipment terminals
IEC 60417 /
Graphical symbols To identify the control by
for use on 5130/ Pulse which a pulse is started.
: General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017 / Earth, neither the symbol 5018 nor
: Ground : - )
equipment 5019 is explicily required.
IEC 60417 / : . .
o ety e st
for use on 5115/ Slgnal lamp : ) 9
) lamp(s) is (are) switched on or
equipment off

q

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking applicable European Union
93/42/EEC P P
regulations
ISO 7000/ . :
Graphical symbols Indlcates'a pqtentlal'ly .

0434B / hazardous situation which, if

for use on . . .

) Warning symbol not avoided, could result in
equipment

death or serious injury

12




ISO 7000/
Graphical symbols
for use on
equipment

3. Precautions

Read this manual before attempting to use the 10 1/Os Digital Module CPU ARDUINO NANO
and follow its descriptions for reference during operation.

3.1  Arduino Board

This version of 10 I/Os Digital Module PLCs include Arduino NANO Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate 10 I/Os Digital Module according to the performance specifications
described in this manual.

Before using 10 1/Os Digital Module CPU ARDUINO NANO under different conditions from
what has been specified in this manual or integrating 10 1/Os Digital Module CPU ARDUINO
NANO to nuclear control systems, railroad systems, aviation systems, vehicles, combustion
systems, medical equipment, amusement machines, safety equipment and other systems,
machines, and equipment that may have a serious influence on lives and property if used
improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and
performance characteristics of 10 I/Os Digital Module are sufficient for the systems, machines,
and equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operating the 10 I/Os
Digital Module.

13
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4. Software Interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically, it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to always have the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences et

Settings | Network

Sketrhboolk location:

C:\Users\albert\Documents\Arduino Browse
Editor language: English (English) | frequires restart of Arduina)
Editor font size: 15

Interface scale: Automatic | 100 = %  (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: None v

[Jpisplay line numbers

[Jenable Code Folding

Verify code after upload

[Juse external editor

Check for updates on startup

Update skatch files th new extension on save (,pde -> .ina)

Save when verifying or uploading

Additional Boards Manager URLs: | http://apps. industrialshields. com/main/arduino/boards/pack-age_industrialshields_inde:| [

More preferences can be edited directly in the file
Ci\Users\Albert\AppData'Local\Arduino15\preferences. it
(edit only when Arduino is not running)

oK Cancel

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

14
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4. Go to: Tools -> Board: ... -> Boards Manager

@ sketch_jan18a Arduino 1.8.13
Archivo Editar Programa  Herramientas Ayuda

Auto Formato T
Archivo de programa
\jan1Ba Reparar codificacion & Recargar.

- =] %

) Administrar Biblictecas. Ctri+Mays+1 -
I setup{  wmonitorSerie Ctrl+Mayis+M
// put yq Seral Plomer CrlsMaylsel |} once:

WiFi101 / WIFININA Firmware Updater

} Placa: *10 105 PLC Family” * Gestor de tarjetas..
Madel: *10 105 PLC’ | Arduino AVR Boards 14
Puerto * ESP32 Arduino
1 Loop ()|  Obteninformacion de la piaca Incustrial Shields boards g

/ v Industrial Shields ESP32 modules >

/ put vy Programador | F e .
Indusirial Shields megaAVR Boards >
S —— ustria) Shields megaAVR Boards

>

5. Search for “industrialshields-megaavr” on the browser.
@ Gestor de tarjetas X
Tipo Todos v | |industrialshields|
industrialshields ~

versidn 1.1.31 INSTALLED

Tarjetas incluidas en éste paquete

ARDBOX family, ARDBOX DALI family, ARDBOX GPRS family, ARDBOX LoRa family, ARDBOX WiFi/BT family, M-Duino family, M-Duino DALI family,
M-Duino GPRS family, M-Duino LoRa family, M-Duino WiFi/BT family, Spartan family.

Online Help

More Info

industrialshields-esp32

version 1.0.2 INSTALLED
Tarjetas incluidas en éste paquete
WiFi/BT module, 10 I0s PLC family.

Online Help
More Info

industrialshields-megaavr

version 1.0.1 INSTALLED
Tarjetas incluidas en éste paquete
10 105 PLC (Nano Every).

Online Help
More Info

W

Eliminar

Cerrar

6. Click install industrialshields-megaavr (selecting the latest version).



Following these steps, you will be able to see now the Industrial Shields megaAVR Boards:

@ sketch_jan18a Arduino 1.813 - o x
Archivo Editar Programa  Herramientas Ayuda
Auto Formato cu+T
Archivo de programa
sketch_jan1Ba Reparar codificacion & Recargar.
. Administrar Bibliotecas. Crl+Mayisel =
1 setup(  wonitorserie Cut+Mayds+M
// put yq SerialPloter CrisMaylssl ) opce:
WIFI101 / WIFININA Firmware Updater
} Placa: *10 105 PLC Family” 3 Gestor de taijetas..
Model: *10 105 PLC Y Arduing AVR Boards
Puerto Y ESP32 Arduino
1 loop() Obininformacion de la placa Industrial Shields boards
// put y brogramador Industrial Shields ESP32 modules >

Cuemar Bcotloader Industrial Shields megaAVR Boards [#] 10105 PLC Family

Once it is selected 10 I0s PLC Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family. In this case 10 10S PLC.

@ sketch_jan18a Arduino 1.813 - o x

Archivo Editar Programa  Herramientas Ayuda
Auto Formato cu+T
Archivo de programa

sketch_jan1Ba Reparar codificacion & Recargar.
Administrar Bibliotecas. Crl+Mayisel =
1 setup(  wonitorserie Cut+Mayds+M
// put yq SerialPloner CrisMaylssl ) opce:

WiFi101 / WIFININA Firmware Updater

} Placa: “10 105 PLC Family 3
Madel: “10 105 PLC* »[# wiosac
Puerto 1 10105 PLC Relay
1 loop ()  Obninformacion de la placa
[/ put y Programador » repeatedly:

Quemar Bootloader

Also, there are some examples of programming in File -> Examples -> 10 10S PLC Family.

Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/
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5. How to connect PLC ARDUINO NANO to PC

- Connect USB port from PLC to PC.

NOTE:
10 1/0Os Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields megaAVR boards -> 10 10S PLC Family
- Select the correct M-Duino Board: 10 10S PLC

@ sketch_jan18a Arduino 1.813 - o x
Archivo_Editar Programa | Herramientas Ayuda
Auto Formato culsT
Archivo de programa
shatch_janiBa Reparar codificacion & Recargar.
. Administrar Biblictecas. Ctrl+Mayis+| =
1 setup(  wonitorserie Cut+Mayds+M
// put yq Seral Plomer CrisMaylssl ) opce:

WiFi101 / WIFININA Firmware Updater

} Placa: “10 105 PLC Family” 3
Madel: “10 105 PLC* »[# wiosac
Puerto 1 10105 PLC Relay
1 loop ()  Obninformacion de la placa
[/ put y Programador » repeatedly:

Quemar Bootioader

- Select the correct port

@ sketch_jan18a Arduino 1.8.13
Archivo Editar Programa  Hemamientas Ayuda

- o x
Auto Formato T
Archivo de programa
sketch jan1Ba Reparar codificacion & Recargar.

Administrar Bibliotecas. Ctrl+ Mayds+|

I setup(  wonitor Serie Ctrl+Mayis+M
// put yd  SeralPlater Crl+Maylssl | once:

WiFi101 / WIFININA Firmware Updater

} Placa: “10 105 PLC Family”
Model: 10 105 PLE »
Puerto: “COM1S (10 105 PLC Family)” i Puertos Serie
1 loop ()  Obninformacion de la placa ¥ COM15 (10 105 PLC Family)
[/ put y Pragramador » repeatedly:

Quemar Bootloader

17



6. How to connect PLC to power supply

- 101/0s Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[ vomensurru]
—b GHND I

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
DIN Rail:

-12vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,
the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7. 10 1/0s Digital Module pinout:

7.1  Left Zone Connections
= £
=) o
o o <
0 o
o= £ 35
= c 3 c
o 2
20 < T
Q0.9 D9 Digital Output
Q0.8 D6 Digital Output
Q0.7 D5 Digital Output
Q0.6 D3 Digital Output
Q0.5 D2 Digital Output
Q04 A6 Digital Output
Q0.3 A3 Digital Output
Q0.2 A2 Digital Output
Q0.1 Al Digital Output
Q0.0 A0 Digital Output

Output Pins

Output Pins

Power supply connectors

(12 to 24Vdc / GND)
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Right Zone Connections

7.2

= £

=] a -

S o
82 £ 3
= c _g =
o = S
— O < [y
10.9 D9 Digital Input
10.8 D6 Digital Input
10.7 D5 Digital Input
10.6 D3 Digital Input
10.5 D2 Digital Input

GNDCOM2 - Ground
10.4 A6 Digital Input
10.3 A3 Digital Input
10.2 A2 Digital Input
10.1 Al Digital Input
10.0 AO Digital Input
GNDCOM1 - Ground

10.8
107
106
10.5
GNDCOM 1

Input Pins

Common GND

Input Pins

Common GND
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7.3  Top Zone Connections

RS5489
(]
+ (ON®)]
Sl<bzz L
=
—— L 'y
I I.
—
I i —r
GND RS485 4 |\ MUST NOT BE MICRO ETHERNET POWER
pins e CONMNECTED USE

NOTE: In case you need to activate the reset button, it can be found by opening the top cover
and accessing the white reset button of the Arduino Nano board integrated inside de

enclosure.

NOTE: The LEDs positioned at the top of the PLC, which go from led 0 to 9 refer to both inputs
and outputs.

For example, if you are using input 10.9, LED 9 on the top cover of the PLC will indicate the
signal status of this input.

If output Q0.9 is being used, LED 9 on the upper cover of the PLC will indicate the status of the
signal of this output.

An input and an output with the same nomenclature can never work at the same time (see
jumper configuration on section 7).
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8. Jumper configuration

8.1

General jumper configuration

The 10 I/Os Digital Module provide 10 digital pins that can act as both input and output. However, they
can only be working as one option at a time, so if their function is wished to be changed the jumpers
must be adjusted. The board is divided in four zones for controlling the I/Os pins, the GND and the I/Os
voltages. Also, the 1/Os pins are divided in two blocks (0.9 to 0.5 and 0.4 to 0.0) that must be supplied
with the same voltage. In order to configure the pins properly, all the zones of the same pin must be set
correctly following the succeeding tables.

Warning!

If a pin is supplied with AC voltage, the entire block must be supplied with the same
voltage type. In the same way, if a pin is supplied with DC voltage, the entire block
must be supplied with DC voltage.

LEFT RIGHT
1 2 3 1 2 3
IN ouT IN - ouT

JUMPER ZONE 2

External GND Board GND
1 2 3 1 2 3

JUMPER ZONE 3

WITHOUT WITH
230V 3.3-24V

This jumper zone makes the selection between using the pins as Inputs
or Outputs. There is a Jumper Zone 1 with three pins on each side of
the board. In the case of using the pins as Inputs, the jumper must be
connected on the pins 1 and 2. Otherwise, if the pin is wished to work
as an Output, connect it on the pins 2 and 3. Both zones must be
connected on the same way in order to work properly. See an example
on the section 8.2.

The Jumper Zone 2 is for choosing between the board ground and an
external one. If the Board GND is chosen using the pins 2 and 3, the pin
will work using the common ground of the device. In the case of using
and external ground, set the jumper on the left side connecting it to
the pins 1 and 2. See an example on the section 8.2.

These jumpers have to be set depending on the alimentation that the
circuit is supplied with. If a power supply voltage of between 3V - 24V
is being used, the switch must be connected as the Jumper Zone 3
photo. In the case of a 230 V power supply then the jumper must not
be connected. See an example on the section 8.2.
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& Warning!

Outputs: if the pin is working as output, its jumper of Zone 3 must be
connected as the 3.3 — 24 V option.

Inputs: if the pin is working as input, DO NOT connect the jumper if you are
using a power supply voltage of 230V as it will damage the device and could

burn it.

JUMPER ZONE 4

5V

24V

This jumper zone makes the choosing between a 5V and 24 V. The 24V
option will be used in the case of using the pins as OUTPUT as it will
provides the same voltage as the input voltage of the PLC, while the 5V
option will be reserved for the case of working as an INPUT. Set the
jumper on the 1st and 2nd position for the 5 V choice or hte 2nd and
3rd pin for the 24V option. See an example on the section 8.2.
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ZONE 3 ZONE 2

ZONE 2
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8.2  1/0s Configuration examples
Input mode

Low voltage
This is an exemple to configure 0.9 as an input with the 3.3-24V current range.

ZONE 2

ZONE 3

DISCOMMECT

ﬂ DO NOT

O
O
O
O
O
O
O
O
O
O

coopoo8 oo0opooo0
S = MWk T R = = i =

O
o
O
O
O
O
O
O
O

ZONE 2
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High voltage
This is an exemple to configure 0.9 as an input with the 230V current range.

ZONE 2

ZONE 3

DISCONMNECT

ﬂ DO NOT

O
O
O
O
O
O
O
O
O
O

ooo0oo0oo0sf ooooo0
o B N WA U o =~ 0 0

O
O
O
O
O
O
O
O
O

ZONE 2
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Output mode

Low voltage
This is an exemple to configure 0.9 as an output with the 3.3-24V current range.

ZONE 2

ZONE 3

DISCOMNECT

A covor

ZONE 2
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9. I/0s Communications

9.1 RS485

The RS-485 is a half-duplex serial communication. The 10 I/Os PLC uses the MAX841CSA for the
RS-485 communication. In the following photo you can see the internal schematic of the PLC of
the connection between Arduino NANO pins, the RS-485 chip and its outputs.

10 1/0Os PLC

~
MAX481CSA B
.

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

9.2 Ethernet

10 1/Os Ethernet port controller is based on w5500 IC, which is the IC compatible with Arduino
Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the 10 1/Os.
In the 10 1/Os, W5500 IC communicates to the NANO board via SPI bus.
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10.

Typical Connections

]' 7
o.rl-- Olos
= i
ui- 17|04
3.3V - 24V 10.0 i D
1230 GND GND1 (R 18 _I___l_ 0o
GND POWER
12/24V B ooraw
Download the MOUIND LAYOUT:
Froe warw ndusinalshesids cosn
DIGITAL NON-ISOLATED OUTPUT
\ /
g a -
070 g Ulos
o5 n.‘ﬂ[: 04
030 g Ol02
m_!__'. £ ¢ o0
w0 Olen
? -___ Qoo
GND i
12/24V
5 DIGITAL OUT
! Downdosd the MOUIND LAYOUT!
From wiwe snfusimisiahisils com
3 gi ! -

Signal
Qutput

3.3-24v
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11. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/6-G-2,5 THT — 1963502 from

Phoenix contact. MC0,5/6-G-2,5THT & MCO0,5/5-G-2,5THT

Connection details:

Article reference MC 0,5/6-G-2,5 THT
Height 8,1Imm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference M1,5/ 6-G-
3,81
Height [h] 10.65mm
Pitch 3.81mm
Overall height (height 7.25mm

without welding pin)

Article reference

IMC 1,5/ 6- ST-3,81

Lenght [I] 18.45mm
Width [w] 23.65mm
Height [h] 11.1mm
Pitch 3.81mm
Overall height 11.1mm
(height without
welding pin)
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https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1

12.

10 I/0s Family Dimensions:

45mm width

&

114

- DIN rail mounting:

Profilato o cappello TH 35-7,5
Top hat rail TH 35-7,5

Prafilato o coppello TH 35-15
Top hat rail TH 35-15

15 5
—
155,

]IU.M — |

| o 1
RO8 & 7‘\

R12
— 303 k08
% -
= —-—L 1+0.04
j;‘— Sezione A / Section A R12

0.3 max —=— ~ | ’ 2,2 min. finoa / To 2,5 max

(=3

1

< Sezione A/ Section A

CARATTERISTICHE METODO  UNITA'"  BLEND FEATURES TEST UNITS BLEND
DI MISURA _PU/ABS METHOD PU/ABS
Meccaniche  Resigeneo o tmzioneallo srenvomento  ASTM D638 MPo 68 Mechanical test Resistnce o tensile stess o vield ASTMDS3S MR 68
Resighrea o taziones it KSTI D638 MPo 4 Tensilestength ASTD 4
Allungamento o rothvm KTMD838 % 9 Utimante elongation ASTMD638 % 9
Hodub in lesione ASTADT0  WPo 27894 Fing modulis ASTHDT0 MRy 7094
Prowa I20d con intoglio 5018014 Xu' 55 lrod test noched 15018014 Yym’ 55
Termiche Temp. di nmmolimento Vit metodo B AT DIS2S  °C 114 Thermal test Vit sodtening temperature method B ASTMDISS  °C 114
Temperatum Riotto 1.8 My KTMDB48  °C 97 i e 181 WP ASTMDS48  “C 9
Fisiche Peso pdfco STHD792  gimn3 12 Physical test  Specifc gmvity ASTHDTR?  giand 121
Ritio nello stompo TMDISS % 0406 Mould shrinkoge ASTMD9SS % 0406
Mt Flow Index 260°C - 98 ISTADIZE  gi10° 111 Mt Fow tndes 260°C - 9B ASTMDIZ®E  g10° 11
Comportamento Abesinguerea (mm di pessor) 4 - V-0(08) Flame fest  Self atinguisher (thickness in mim) ULo4 - V0(0.8)
alla fiomma ___Fib Incondescen. 32 mm IEC695.21  °C 960 Inondescente thrend 32 mm 189521 °C 960

Italtronic i riserva il diritto di modificore il moteriole con cui realizza i propri prodotti
senzo obbligo di preawiso.

Itoltronic con operate any change of the moterials without being obliged to forewam.
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13.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the 10 1/0Os DIGITAL MODULE from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
10 I/Os Digital Module. When configuring the layout of the 10 I/Os Digital Module inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Also consider the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and high
energy, rapidly switched DC wiring.

Provide adequate clearance for cooling and wiring 10 1/Os Digital Module. Is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
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above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided,;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to lose parts or wires and
cause malfunctions. Excessive tightening can damage the screws and / or the module,
with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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Ref. 013001000100

Rev.1: 18-01-2021

14. Revision Table
Revision Number Date Changes
0 14/09/2020 First implementation
1 18/01/2021 Added Software Section — 42
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